## LIST OF EXPERIMENTS

<table>
<thead>
<tr>
<th>EXP NO.</th>
<th>NAME OF THE EXPERIMENT</th>
<th>PAGE NO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To determine and verify Thevenin’s and Norton’s theorem.</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>To calculate and verify 'Z' parameters of two-port network.</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>To calculate and verify 'Y' parameters of two-port network.</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>To calculate and verify 'ABCD' parameters of two-port network.</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>To calculate and verify 'H' parameters of two-port network.</td>
<td>13</td>
</tr>
<tr>
<td>6</td>
<td>To determine equivalent parameters of parallel connection of two-port network.</td>
<td>15</td>
</tr>
<tr>
<td>7</td>
<td>To determine equivalent parameters of parallel connection of two-port network.</td>
<td>17</td>
</tr>
<tr>
<td>8</td>
<td>To determine the equivalent parameters of series connection of two port network.</td>
<td>19</td>
</tr>
<tr>
<td>9</td>
<td>To determine the A’B’C’D’ parameters of the cascade connection of two-port network.</td>
<td>21</td>
</tr>
<tr>
<td>10</td>
<td>To Study P-Spice Software.</td>
<td>23</td>
</tr>
<tr>
<td>11</td>
<td>Introduction to circuit creation and simulation software TINAPRO</td>
<td>25</td>
</tr>
<tr>
<td>12</td>
<td>Introduction to Layout Tool, and creating Layout board using TINAPRO</td>
<td>27</td>
</tr>
<tr>
<td>13</td>
<td>Design a RLC resonance circuit &amp; verify the transient response for different values of R, L &amp; C</td>
<td>28</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 1

AIM: To determine and verify Thevenin’s and Norton’s Theorem.

APPARATUS REQUIRED: Power Supply, Bread Board, Connecting Leads, Voltmeter, Ammeter

THEORY:

THEVENIN’S THEOREM:
As applied to the network ckt may be stated as the current flowing through a load resistance $R_L$ connected across any two terminals A and B of a linear bilateral network is given by $\frac{V_{TH}}{R_{TH} + R_L}$ where $V_{TH}$ is the open ckt volatge and $R_{TH}$ is the internal resistance of the network from the terminal A to B with all volatge sources replaced with their internal resistances and current sources with infinite resistance.

NORTON’S THEOREM:
Replaces the electrical network by an equivalent constant current source and a parallel resistance. Norton’s equivalent resistance $R_N = \frac{R_1 \times R_2}{R_1 + R_2}$. Actual load current in the circuit $I_{L1}$ theoretical load current $I_{L2} = \frac{I_{SC} \times R_N}{R_N + R_L}$, $I_{SC}$ is the short circuit current.

CIRCUIT DIAGRAM:

1) THEVENIN’S CIRCUIT DIAGRAM:

![Thevenin's Circuit Diagram](image1)

2) NORTON’S CIRCUIT DIAGRAM:

![Norton's Circuit Diagram](image2)
PROCEDURE:

THEVENIN PROCEDURE:  
Thevenin's Theorem is a way to reduce a network to an equivalent circuit composed of a single voltage source, series resistance, and series load.

Steps to follow for Thevenin's Theorem:
(1) To find the current flowing through the load resistance $R_L$ as shown in fig. Remove $R_L$ from the ckt temporarily and leave the terminals A and B open circuited.
(2) Calculate the open ckt voltage $V_{TH}$ which appears across terminal A and B.
$$V_{TH} = I_{TH} R_{TH}$$
This is called Thevenin’s voltage.
(3) Now calculate $R_{TH} = R_1 R_2 / (R_1 + R_2)$. This is called Thevenin’s Resistance.
(4) Analyze voltage and current for the load resistor following the rules for series circuits.
$$I_L = V_{TH} / (R_L + R_{TH})$$
$$V_{TH} = E x R_2 / (R_1 + R_2)$$

NORTON THEOREM:  
Norton's Theorem is a way to reduce a network to an equivalent circuit composed of a single current source, parallel resistance, and parallel load.

Steps to follow for Norton's Theorem:
(1) Find the Norton source current by removing the load resistor from the original circuit and calculating current through a short (wire) jumping across the open connection points where the load resistor used to be.
(2) Find the Norton resistance by removing all power sources in the original circuit (voltage sources shorted and current sources open) and calculating total resistance between the open connection points.
(3) Draw the Norton equivalent circuit, with the Norton current source in parallel with the Norton resistance. The load resistor re-attaches between the two open points of the equivalent circuit.
(4) Analyze voltage and current for the load resistor following the rules for parallel circuits.

OBSERVATION TABLE:

1) THEVENIN’S TABLE

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2) **NORTON’S TABLE**

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Applied Voltage (volts)</th>
<th>IN (amp.)</th>
<th>R_N (ohms)</th>
<th>I_L1 (amp)</th>
<th>I_L2 (amp)</th>
<th>Error I_L1-I_L2</th>
</tr>
</thead>
</table>

**RESULT:** THEVENIN’S and NORTON’S THEOREM has been verified.

**DISCUSSION:** Thevenin’s and Norton’s theorems are dual theorems and can be used in the reduction of circuit analysis.

**PRECAUTIONS:**

- a) Make the connections according to the circuit diagram. Power supply should be switched off.
- b) Connections should be tight.
- c) Note the readings carefully.

**QUIZ / ANSWERS:**

Q.1 To what type of circuit thevenin’s theorem is applicable
   A. Linear and bilateral.

Q.2 What is the use of thevenin’s theorem?
   A. To convert the complex ckt into a voltage source and a series resistance.

Q.3 How Rth is connected with the ckt?
   A. In series.

Q.4 How is Rth connected with the load resistance?
   A. In series

Q.5 What modification is done in galvanometer to convert it into a ammeter?
   A. A large resistance in parallel

Q.6 What modification is done in the galvanometer to convert it into a voltmeter?
   A. A series resistance

Q.7 Resistance is an active element or the passive?
   A. Passive

Q.8 How will you calculate the Rth?
   A. The resistance between the two terminals

Q.9 In place of current source, what is placed while calculating Rth?
   A. Replace current source by open ckt

Q.10 In place of voltage source which electrical parameters is placed?
A. A short ckt.

Q.11 To what type of network Norton’s theorem applicable?
A. Two terminal linear network containing independent voltage and current sources.

Q.12 How is Rn connected to In?
A. In the parallel

Q.13 What is placed in place of voltage sources while calculating the Rn?
A. Their internal resistance replaces these.

Q.14 Give an example of unilateral ckt?
A. Diode rectifier

Q.15 What is unilateral ckt?
A. Whose characteristics changes with the change in direction of operation

Q.16 Give one example of the bilateral n/w?
A. Transmission lines

Q.17 What is the limitation of ohm’s law?
A. Provided physical conditions do not change

Q.18 What is the reason that ground pin are made of greater diameter in the plugs?
A. R=ρL/A

Q.19 Where is the voltage divider rule applicable?
A. Two resistance in series

Q.20 Where is the current divider rule applicable?
A. When there are two resistances in parallel.
EXPERIMENT NO: 2

AIM: To calculate and verify 'Z' parameters of two-port network.

APPARATUS REQUIRED: Power Supply, Bread Board, Five resistances, Connecting Leads. Voltmeter, Ammeter

BRIEF THEORY: In Z parameters of a two-port, the input & output voltages $V_1$ & $V_2$ can be expressed in terms of input & output currents $I_1$ & $I_2$. Out of four variables (i.e $V_1$, $V_2$, $I_1$, $I_2$) $V_1$ & $V_2$ are dependent variables whereas $I_1$ & $I_2$ are independent variables. Thus,

$$V_1 = Z_{11}I_1 + Z_{12}I_2 \quad ----(1)$$

$$V_2 = Z_{21}I_1 + Z_{22}I_2 \quad ----(2)$$

Here $Z_{11}$ & $Z_{22}$ are the input & output driving point impedances while $Z_{12}$ & $Z_{21}$ are the reverse & forward transfer impedances.

CIRCUIT DIAGRAM:

PROCEDURE:

a) Connect the circuit as shown in fig. & switch ‘ON’ the experimental board.

b) First open the O/P terminal & supply 5V to I/P terminal. Measure O/P Voltage & I/P Current.

c) Secondly, open I/P terminal & supply 5V to O/P terminal. Measure I/P Voltage & O/P current using multi-meter.

d) Calculate the values of Z parameter using Equation (1) & (2).

e) Switch ‘OFF’ the supply after taking the readings.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S.No</th>
<th>When I/P is open ckt</th>
<th>When O/P is open ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$V_2$ $V_1$ $I_2$</td>
<td>$V_2$ $V_1$ $I_1$</td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:

(1) When O/P is open circuited i.e. $I_2 = 0$

$$Z_{11} = \frac{V_1}{I_1} \quad Z_{21} = \frac{V_2}{I_1}$$
When I/P is open circuited i.e. \( I_1 = 0 \)

\[
Z_{12} = \frac{V_1}{I_2} \quad Z_{22} = \frac{V_2}{I_2}
\]

**RESULT/CONCLUSION:** The Z-parameters of the two port network has been calculated and verified.

**DISCUSSION:** The Z-parameters are open circuit parameters.

**PRECAUTIONS:**
- a) Make the connections according to the circuit diagram. Power supply should be switched off.
- b) Connections should be tight.
- c) Note the readings carefully.

**QUIZ/ANSWERS:**

<table>
<thead>
<tr>
<th>Q1. Define Z parameters?</th>
<th>A1. In Z parameters, the input &amp; output voltages ( V_1 ) &amp; ( V_2 ) can be expressed in terms of input &amp; output currents ( I_1 ) &amp; ( I_2 ).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2. List the four variables used in Z-parameter representation</td>
<td>A2. The four variables are ( V_1, V_2, I_1 ) &amp; ( I_2 ).</td>
</tr>
<tr>
<td>Q3. List the two dependent variables used in Z-parameter representation</td>
<td>A3. The two dependent variables are ( V_1 ) &amp; ( V_2 ).</td>
</tr>
<tr>
<td>Q4. List the two independent variables used in Z-parameter representation.</td>
<td>A4. The two independent variables are ( I_1 ) &amp; ( I_2 ).</td>
</tr>
<tr>
<td>Q5. Define input driving point impedance</td>
<td>A5. The input driving point impedance is defined as the ratio of input voltage to the input current</td>
</tr>
<tr>
<td>Q6. Define output driving point impedance</td>
<td>A6. The output driving point impedance is defined as the ratio of output voltage to the output current.</td>
</tr>
<tr>
<td>Q7. Define reverse transfer impedance.</td>
<td>A7. The reverse transfer impedance is defined as ratio of input voltage to the output current.</td>
</tr>
<tr>
<td>Q8. Define forward transfer impedance</td>
<td>A8. The forward transfer impedance is defined as ratio of output voltage to the input current.</td>
</tr>
<tr>
<td>Q9. Write condition for reciprocity.</td>
<td>A9. Condition for reciprocity is ( Z_{12} = Z_{21} ).</td>
</tr>
<tr>
<td>Q10. Write condition for symmetry.</td>
<td>A10. Condition for symmetry is ( Z_{11} = Z_{22} ).</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 3

AIM: To calculate and verify 'Y' parameters of two-port network.

APPARATUS REQUIRED: Power supply, Bread Board, Five resistances, Connecting Leads, Voltmeter, and Ammeter.

BRIEF THEORY: In Y parameters of a two-port, the input & output currents \( I_1 \) & \( I_2 \) can be expressed in terms of input & output voltages \( V_1 \) & \( V_2 \). Out of four variables (i.e \( I_1, I_2, V_1, V_2 \)) \( I_1 \) & \( I_2 \) are dependent variables whereas \( V_1 \) & \( V_2 \) are independent variables.

\[
I_1 = Y_{11}V_1 + Y_{12}V_2 \quad ------(1)
\]

\[
I_2 = Y_{21}V_1 + Y_{22}V_2 \quad ------(2)
\]

Here \( Y_{11} \) and \( Y_{22} \) are the input & output driving point admittances while \( Y_{12} \) and \( Y_{21} \) are the reverse & forward transfer admittances.

CIRCUIT DIAGRAM:

PROCEDURE:

a) Connect the circuit as shown in fig. & switch ‘ON’ the experimental board.

b) First short the O/P terminal & supply 5V to I/P terminal. Measure O/P & I/P current.

c) Secondly, short I/P terminal & supply 5V to O/P terminal. Measure I/P & O/P current using multi-meter.

d) Calculate the values of Y parameter using Eq. (1) & (2).

e) Switch ‘off’ the supply after taking the readings.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S.No</th>
<th>When I/P is short ckt</th>
<th>When O/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( V_2 )</td>
<td>( I_1 )</td>
</tr>
<tr>
<td>------</td>
<td>-----</td>
<td>-----</td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:

(1) When O/P is short circuited i.e. \( V_2 = 0 \)

\[
Y_{11} = I_1/V_1 \quad Y_{21} = I_2/V_1
\]
(2) When I/P is short circuited i.e. $V_1 = 0$

\[ Y_{12} = \frac{I_1}{V_2} \quad Y_{22} = \frac{I_2}{V_2} \]

**RESULT/CONCLUSION:** The Y-parameters of the two port network has been calculated and verified.

**DISCUSSION:** The Y-parameters are short circuit parameters

**PRECAUTIONS:**
- Make the connections according to the circuit diagram. Power supply should be switched off.
- Connections should be tight.
- Note the readings carefully.

**QUIZ/ANSWERS:**

<table>
<thead>
<tr>
<th>Q1. Define Y parameters?</th>
<th>A1. In Y-parameters the input &amp; output currents $I_1$ &amp; $I_2$ can be expressed in terms of input &amp; output voltages $V_1$ &amp; $V_2$.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2. List the four variables used in Y-parameter representation</td>
<td>A2. The four variables are $I_1$, $I_2$, $V_1$ and $V_2$.</td>
</tr>
<tr>
<td>Q3. List the two dependent variables used in Y-parameter representation</td>
<td>A3. The two dependent variables are $I_1$ &amp; $I_2$</td>
</tr>
<tr>
<td>Q4. List the two independent variables used in Y-parameter representation</td>
<td>A4. The two independent variables are $V_1$ &amp; $V_2$.</td>
</tr>
<tr>
<td>Q5. Define input driving point admittance</td>
<td>A5. The input driving point admittance is defined as the ratio of input current to the input voltage.</td>
</tr>
<tr>
<td>Q6. Define output driving point admittance</td>
<td>A6. The output driving point admittance is defined as the ratio of output current to the output voltage.</td>
</tr>
<tr>
<td>Q7. Define reverse transfer admittance</td>
<td>A7. The reverse transfer ratio is defined as ratio of input current to the output voltage</td>
</tr>
<tr>
<td>Q8. Define forward transfer admittance</td>
<td>A8. The forward transfer ratio is defined as ratio of output current to the input voltage</td>
</tr>
<tr>
<td>Q9. Write condition for reciprocity.</td>
<td>A9. Condition for reciprocity is $Y_{12} = Y_{21}$</td>
</tr>
<tr>
<td>Q10. Write condition for symmetry.</td>
<td>A10. Condition for symmetry is $Y_{11} = Y_{22}$</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 4

AIM: To calculate and verify 'ABCD' parameters of two-port network

APPARATUS REQUIRED: Power Supply, Bread Board, Five resistances, Connecting Leads, Voltmeter, and Ammeter.

BRIEF THEORY: ABCD parameters are widely used in analysis of power transmission engineering where they are termed as “Circuit Parameters”. ABCD parameters are also known as “Transmission Parameters”. In these parameters, the voltage & current at the sending end terminals can be expressed in terms of voltage & current at the receiving end. Thus,

\[ V_1 = AV_2 + B(-I_2) \]
\[ I_1 = CV_2 + D(-I_2) \]

Here “A” is called reverse voltage ratio, “B” is called transfer impedance “C” is called transfer admittance & “D” is called reverse current ratio.

CIRCUIT DIAGRAM:

![Circuit Diagram]

PROCEDURE:

a) Connect the circuit as shown in fig. & switch ‘ON’ the experimental board.
b) First open the O/P terminal & supply 5V to I/P terminal. Measure O/P voltage & I/P current
c) Secondly, short the O/P terminal & supply 5V to I/P terminal. Measure I/P & O/P current using multi-meter.
d) Calculate the A, B, C, & D parameters using the Eq. (1) & (2).
e) Switch ‘off’ the supply after taking the readings.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S.No</th>
<th>When O/P is open ckt</th>
<th>When O/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V_1</td>
<td>V_2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:

(1) When O/P is open circuited i.e. I_2 = 0
   \[ A = \frac{V_1}{V_2} \quad C = \frac{I_1}{V_2} \]
(2) When O/P is short circuited i.e. V_2 = 0
RESULT/CONCLUSION: The ABCD-parameters of the two-port network has been calculated and verified.

DISCUSSION: ABCD parameters are transmission parameters.

PRECAUTIONS:
   a) Make the connections according to the circuit diagram. Power supply should be switched off.
   b) Connections should be tight.
   c) Note the readings carefully.

QUIZ/ANSWERS:

| Q1. Define transmission parameters | A1. In these parameters, the voltage & current at the sending end terminals can be expressed in terms of voltage & current at the receiving end. |
| Q2. Why ABCD parameters are also called as transmission parameters? | A2. ABCD parameters are also called as transmission parameters because these are used in the analysis power transmission lines |
| Q3. Where they are used? | A3. Transmission line theory & cascade network |
| Q4. Define reverse voltage ratio (A). | A4. It is defined as the ratio of sending end voltage to the receiving end voltage |
| Q5. Define transfer impedance (B). | A5. It is defined as the ratio of sending end voltage to the receiving end current with the receiving end current assumed to be in reverse direction |
| Q6. Define transfer admittance (C). | A6. It is defined as the ratio of sending end current to the receiving end voltage |
| Q7. Define reverse current ratio (D). | A7. It is defined as the ratio of sending end current to the receiving end current with the receiving end current assumed to be in reverse direction |
| Q8. Write the units of parameters B & C. | A8. Unit of parameter B is ohm & of C is mho. |
| Q9. Write the units of parameters A & D. | A9. Both parameters A & D are unit less. |
| Q10. Write the condition for symmetry & Reciprocity. | A10. The condition for symmetry is $A = D$ & the condition for reciprocity is $AD - BC = 1$. |
**EXPERIMENT NO: 5**

**AIM:** To calculate and verify 'H' parameters of two-port network

**APPARATUS REQUIRED:** Power supply, Bread Board, Five resistances, Connecting Leads, Multimeter.

**BRIEF THEORY:** In ‘h’ parameters of a two port network, voltage of the input port and the current of the output port are expressed in terms of the current of the input port and the voltage of the output port. Due to this reason, these parameters are called as ‘hybrid’ parameters, i.e. out of four variables (i.e. V₁, V₂, I₁, I₂) V₁, I₂ are dependent variables. Thus,

\[ V₁ = h₁₁I₁ + h₁₂V₂ \]  
\[ I₂ = h₂₁I₁ + h₂₂V₂ \]  

H₁₁ and H₂₂ are input impedance and output admittance. H₂₁ and H₁₂ are forward current gain and reverse voltage gain.

**CIRCUIT DIAGRAM:**

![Circuit Diagram](image)

**PROCEDURE :**

a) Connect the circuit as shown in fig. & switch ‘ON’ the experimental board.

b) Short the output port and excite input port with a known voltage source Vs. So that V₁ = Vs and V₂ = 0. We determine I₁ and I₂ to obtain h₁₁ and h₂₁.

c) Input port is open circuited and output port is excited with the same voltage source Vs. So that V₂ = Vs and I₁ = 0, we determine I₂ and V₁ to obtain h₁₂ and h₂₂.

d) Switch ‘off’ the supply after taking the readings.

**OBSERVATION TABLE:**

<table>
<thead>
<tr>
<th>S.No</th>
<th>When O/P is short ckt</th>
<th>When I/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V₁</td>
<td>I₁</td>
</tr>
<tr>
<td></td>
<td>V₂</td>
<td>V₁</td>
</tr>
</tbody>
</table>

**SAMPLE CALCULATION:**

1. When O/P is short circuited i.e. V₂ = 0
   \[ h₁₁ = V₁/I₁ \]
   \[ h₂₁ = I₂/I₁ \]

2. When I/P is open circuited i.e. I₁ = 0
   \[ h₁₂ = V₁/V₂ \]
   \[ h₂₂ = I₂/V₂ \]
RESULT/CONCLUSION: The h-parameters of the two port network has been calculated and verified.

DISCUSSION: The h-parameters are short circuit parameters

PRECAUTIONS:
  a) Make the connections according to the circuit diagram. Power supply should be switched off.
  b) Connections should be tight.
  c) Note the readings carefully.

QUIZ/ANSWERS:

<table>
<thead>
<tr>
<th>Q1. Define H parameters?</th>
<th>A1. In ‘h’ parameters of a two port network, voltage of the input port and current of the output port are expressed in terms of the current of the input port and voltage of the output port.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2. List the four variables used in h-parameter representation</td>
<td>A2. The four variables are $V_1$, $V_2$, $I_1$ and $I_2$.</td>
</tr>
<tr>
<td>Q3. List the two dependent variables used in h-parameter representation</td>
<td>A3. The two dependent variables are $V_1$ &amp; $I_2$.</td>
</tr>
<tr>
<td>Q4. List the two independent variables used in h-parameter representation</td>
<td>A4. The two independent variables are $I_1$ &amp; $V_2$.</td>
</tr>
<tr>
<td>Q5. Define input impedance</td>
<td>A5. $h_{11} = V_1/I_1$.</td>
</tr>
<tr>
<td>Q6. Define output admittance</td>
<td>A6. $h_{22} = I_2/V_2$.</td>
</tr>
<tr>
<td>Q7. Define forward current gain</td>
<td>A7. $h_{21} = I_2/I_1$.</td>
</tr>
<tr>
<td>Q8. Define reverse current gain</td>
<td>A8. $h_{12} = V_1/V_2$.</td>
</tr>
<tr>
<td>Q9. Write condition for reciprocity.</td>
<td>A9. Condition for reciprocity is $h_{12} = h_{21}$.</td>
</tr>
<tr>
<td>Q10. Write condition for symmetry.</td>
<td>A10. Condition for symmetry is $h_{11} = h_{22}$.</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 6

AIM: To calculate and verify ‘G’ parameters of two-port network.

APPARATUS REQUIRED: Power supply, Bread Board, Five resistances, Connecting Leads, Multimeter.

BRIEF THEORY: In ‘g’ parameters of a two port network, the current at the input port $I_1$ & the voltage at the output port $V_2$ can be expressed in terms of $I_2$ & $V_1$.

\[
I_1 = g_{11} V_1 + g_{12} I_2 \quad (1)
\]
\[
V_2 = g_{21} V_1 + g_{22} I_2 \quad (2)
\]

$G_{11}$ and $G_{22}$ are input driving point admittance and output driving point impedance. $G_{21}$ and $G_{12}$ are forward current gain and reverse voltage gain.

CIRCUIT DIAGRAM:

![Circuit Diagram]

PROCEDURE:

1) Connect the circuit as shown in fig. & switch ‘ON’ the experimental board.
2) Open the output port & excite input port with a known voltage source $V_s$, So that $V_1 = V_s$ & $I_2 = 0$. We determine $I_1$ & $V_2$ to obtain $g_{11}$ & $g_{21}$.
3) Input port is short circuited and out port is excited with the same voltage source $V_s$, so that $V_2 = V_s$ & $V_1 = 0$. We determine $I_1$ & $I_2$ to obtain $g_{12}$ & $22$.
4) Switch ‘off’ the supply after taking the readings.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S.No</th>
<th>When O/P is open ckt</th>
<th>When I/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$V_1$</td>
<td>$I_1$</td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:

1) When O/P is open circuited i.e. $I_2 = 0$

$g_{11} = \frac{I_1}{V_1}$  \quad $g_{21} = \frac{V_2}{V_1}$

2) When I/P is short circuited i.e. $V_1 = 0$

$g_{12} = \frac{I_1}{I_2}$  \quad $g_{22} = \frac{V_2}{I_2}$

RESULT/CONCLUSION: The G-parameters of the two port network has been calculated and verified.
**PRECAUTIONS:**

a) Make the connections according to the circuit diagram. Power supply should be switched off.
b) Connections should be tight.
c) Note the readings carefully.

**QUIZ/ANSWERS:**

<table>
<thead>
<tr>
<th>Q1. Define G parameters?</th>
<th>A1. In ‘G’ parameters of a two port, the current at the input port $I_1$ &amp; the voltage at the output port $V_2$ can be expressed in terms of $I_2$ &amp; $V_1$, network.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q2. List the four variables used in g-parameter representation</td>
<td>A2. The four variables are $V_1$, $V_2$, $I_1$ and $I_2$.</td>
</tr>
<tr>
<td>Q3. List the two dependent variables used in g-parameter representation</td>
<td>A3. The two dependent variables are $I_1$ &amp; $V_2$.</td>
</tr>
<tr>
<td>Q4. List the two independent variables used in h-parameter representation</td>
<td>A4. The two independent variables are $V_1$ &amp; $I_2$.</td>
</tr>
<tr>
<td>Q5. Define input driving point admittance</td>
<td>A5. $g_{11} = I_1/V_1$.</td>
</tr>
<tr>
<td>Q6. Define output driving point impedance</td>
<td>A6. $g_{22} = V_2/I_2$.</td>
</tr>
<tr>
<td>Q7. Define forward current gain</td>
<td>A7. $g_{21} = V_2/I_1$.</td>
</tr>
<tr>
<td>Q8. Define reverse voltage gain</td>
<td>A8. $g_{12} = I_1/I_2$.</td>
</tr>
<tr>
<td>Q9. Write condition for reciprocity.</td>
<td>A9. Condition for reciprocity is $g_{12} = g_{21}$.</td>
</tr>
<tr>
<td>Q10. Write condition for symmetry.</td>
<td>A10. Condition for symmetry is $g_{11} = g_{22}$.</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 7

AIM: To determine equivalent parameters of parallel connection of two-port network


BRIEF THEORY: Consider two port N/Ws connected in parallel so that they have common reference node, then the equation of the N/Ws A&B in terms of Y parameters are given by -

\[

g_1 = g_{11A} + g_{11B} \\
g_{12} = g_{12A} + g_{12B} \\
g_{21} = g_{21A} + g_{21B} \\
g_{22} = g_{22A} + g_{22B}
\]

Thus we see that each Y parameter of the parallel N/W is given as the sum of the corresponding parameters of the individual N/Ws.

CIRCUIT DIAGRAM:

PROCEDURE:

a) Connect the N/Ws A&B separately on the Bread board according to the fig.

b) Take the Reading according to the observation table & calculate Y parameters for both N/Ws & add them.

c) Connect two N/Ws A&B in parallel & take the readings.

d) Calculate the Y parameters of parallel connected N/Ws.

e) Verify that the sum of parameters of A&B N/Ws is equal to the parameters of parallel connected N/Ws.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>When I/P is short ckt</th>
<th>When O/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>V_2</td>
<td>I_1</td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:
(1) When O/P is short circuited i.e. \( V_2 = 0 \)
\[
Y_{11} = \frac{I_1}{V_1} \quad Y_{21} = \frac{I_2}{V_1}
\]
(2) When I/P is short circuited i.e. \( V_1 = 0 \)
\[
Y_{12} = \frac{I_1}{V_2} \quad Y_{22} = \frac{I_2}{V_2}
\]

RESULT/CONCLUSION: The Y-parameters of parallel connection of two-port network has been determined.

DISCUSSION: The overall Y-parameters of a parallel connection is equal to sum of individual network parameters.

PRECAUTIONS:
- a) Make the connections according to the circuit diagram. Power supply should be switched off.
- b) Connections should be tight.
- c) Note the readings carefully.

QUIZ/ANSWERS:

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1. What will be the total admittance if the two networks are connected in series?</td>
<td>A1. The total admittance (Z) = ( Z_1 + Z_2 )</td>
</tr>
<tr>
<td>Q2. What will be the total admittance if the two networks are connected in parallel?</td>
<td>A2. The total admittance (Y) = ( Y_1 + Y_2 )</td>
</tr>
<tr>
<td>Q3. Which parameter is used for the representation of parallel connection of two port network?</td>
<td>A3. Y-parameters</td>
</tr>
<tr>
<td>Q4. Which parameter is used for the representation of series connection of two port network?</td>
<td>A4. Z-parameters</td>
</tr>
<tr>
<td>Q5. Difference between Z &amp; Y parameters</td>
<td>A5. Z-parameters are called open ckt while Y-parameters are called short ckt parameters. Z-parameters are used for series connection while Y-parameters are used for parallel connection.</td>
</tr>
<tr>
<td>Q6. What do you mean by cascade connection?</td>
<td>A6. The network is said to be in cascade when the o/p of one port becomes the input for second n/w.</td>
</tr>
<tr>
<td>Q9. A two port network is simply a network inside a black box &amp; the network has only (a) two terminals (b) two pairs of accessible terminals two pairs of ports</td>
<td>A9. (b)</td>
</tr>
<tr>
<td>Q10. The number of possible combinations generated by four variables taken two at a time in a two-port network is (a) Four (b) two (c) six</td>
<td>A10. (c)</td>
</tr>
</tbody>
</table>
**EXPERIMENT NO: 8**

**AIM:** To determine the equivalent parameters of series connection of two port network

**APPARATUS REQUIRED:** Power Supply, Bread Board, Resistances, Connecting Leads, Multimeter

**BRIEF THEORY:** The Series connection is also called as Series-Series connection, since both input ports & output ports are series connected. Thus,

\[
V_1 = Z_{11}V_2 + Z_{12}I_2 \quad (1)
\]

\[
V_2 = Z_{21}I_1 + Z_{22}I_2 \quad (2)
\]

\(V_1\) & \(V_2\) are dependent variables, \(I_1\) & \(I_2\) are independent variables, \(Z'_{11}\) & \(Z'_{22}\) is Input & Output driving point impedance. \(Z'_{12}\) & \(Z'_{21}\) is Reverse & Forward transfer impedance.

**CIRCUIT DIAGRAM:**

![Circuit Diagram](image)

**PROCEDURE:**

1) Connect the circuit as shown in fig and switch ‘ON’ the experiment board.
2) Open the output port & excite input port with a known voltage source \(V_s\) so that \(V_1 = V_s\) & \(I_2 = 0\). We determine \(I_1\) & \(I_2\) to obtain \(Z'_{11}\) & \(Z'_{21}\).
3) Input port is open circuited & Output port is excited with the same voltage source \(V_s\) so that \(V_2 = V_s\) & \(I_1 = 0\). We determine \(I_2\) & \(V_1\) to obtain \(Z'_{22}\) & \(Z'_{12}\).
4) Switch OFF the supply after taking the readings.

**OBSERVATION TABLE:**

<table>
<thead>
<tr>
<th>S.N.O</th>
<th>When O/P is open ckted</th>
<th>When I/P is open ckted</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(V_1)</td>
<td>(I_1)</td>
</tr>
</tbody>
</table>

**SAMPLE CALCULATION:**

1) When O/P is open circuited i.e. \(I_2 = 0\)
   \(Z'_{11} = \frac{V_1}{I_1}\)  \(Z'_{21} = \frac{V_2}{I_1}\)

2) When I/P is open circuited i.e. \(I_1 = 0\)
   \(Z'_{12} = \frac{V_1}{I_2}\)  \(Z'_{22} = \frac{V_2}{I_2}\)
RESULT/CONCLUSION: The $Z'_{11}$, $Z'_{12}$, $Z'_{21}$, $Z'_{22}$ parameters of two-port network has been determined.

PRECAUTIONS:
   a) Make the connections according to the circuit diagram. Power supply should be switched off.
   b) Connections should be tight.
   c) Note the readings carefully.

QUIZ/ANSWERS:

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1 What do you mean by cascade connection?</td>
<td>A1. The network is said to be in cascade when the output of one port becomes the input for second network</td>
</tr>
<tr>
<td>Q2 A two port network is simply a network inside a black box &amp; the network has only c) two terminals d) two pairs of accessible terminals two pairs of ports</td>
<td>A9.(b)</td>
</tr>
<tr>
<td>Q3 What is Input driving point impedance</td>
<td>A3. $Z'_{11} = V_1/I_1$</td>
</tr>
<tr>
<td>Q4 What is Output driving point impedance</td>
<td>A4. $Z'_{22} = V_2/I_2$</td>
</tr>
<tr>
<td>Q5 What is Reverse Transfer Impedance</td>
<td>A5. $Z'_{12} = V_1/I_2$</td>
</tr>
<tr>
<td>Q6 What is Reverse Transfer Admittance</td>
<td>A6. $Z'_{21} = V_2/I_1$</td>
</tr>
<tr>
<td>Q7 Is $Z$ inversely proportional to $Y$ in one port network?</td>
<td>A7. Yes.</td>
</tr>
<tr>
<td>Q8 Is $Z$ inversely proportional to $Y$ in two port network?</td>
<td>A8. No.</td>
</tr>
<tr>
<td>Q9 The number of possible combinations generated by four variables taken two at a time in a two-port network is (a) Four (b) two (c) six</td>
<td>A9.(c)</td>
</tr>
</tbody>
</table>
EXPERIMENT NO: 9

AIM: To determine the A’B’C’D’ parameters of the cascade connection of two-port network

APPARATUS REQUIRED: Power Supply, Bread Board, Resistances, Connecting Leads, Multi-meter.

BRIEF THEORY: Two port networks are said to be connected in cascade if the output port of the first becomes the input port of the second as shown in fig.

\[ V_1 = A'V_2 + B'(-I_2) \]  
\[ I_1 = C'_2 + D'(-I_2) \]

V1 and I1 are dependent variables; V2 and I2 are independent variables
A’, D’ is Reverse Voltage Ratio & Reverse Current Ratio.
B’, C’ is Reverse Transfer Impedance & Reverse Transfer Admittance.

CIRCUIT DIAGRAM:

PROCEDURE:
1) Connect the circuit as shown in fig and switch ‘ON’ the experiment board.
2) In A, B, C, D parameters, open the output port and excite input port with a known voltage source Vs so that \( V_1 = V_s \) and \( V_2 = 0 \). We determine \( I_1 \) and \( V_2 \) to obtain A’ & C’.
3) The output port is short circuited and input port is excited with the same voltage source \( V_s \) so that \( V_1 = V_s \) & \( V_2 = 0 \). We determine \( I_1 \) & \( I_2 \) to obtain B’ & D’.
4) Switch OFF the supply after taking the readings.

OBSERVATION TABLE:

<table>
<thead>
<tr>
<th>S.N.O</th>
<th>When O/P is open ckt</th>
<th>When O/P is short ckt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( V_2 )</td>
<td>( I_1 )</td>
</tr>
</tbody>
</table>

SAMPLE CALCULATION:
1) When O/P is open circuited i.e. \( I_2 = 0 \)
   \[ A' = \frac{V_1}{V_2} \]  
   \[ C' = \frac{I_1}{V_2} \]
2) When O/P is short circuited i.e. \( V_2 = 0 \)
   \[ B' = \frac{V_1}{-I_2} \]  
   \[ D' = \frac{I_1}{-I_2} \]

RESULT/CONCLUSION: The A, B, C, D parameters of two-port network have been determined.
**PRECAUTIONS:**

a) Make the connections according to the circuit diagram. Power supply should be switched off.
b) Connections should be tight.
c) Note the readings carefully.

**QUIZ/ANSWERS:**

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1 What do you mean by cascade connection?</td>
<td>A1. The network is said to be in cascade when the output of one port becomes the input for second network</td>
</tr>
<tr>
<td>Q2 A two port network is simply a network inside a black box &amp; the network has only e) two terminals f) two pairs of accessible terminals two pairs of ports</td>
<td>A9 (b)</td>
</tr>
<tr>
<td>Q3 What is Reverse Voltage Ratio</td>
<td>A3. $A' = \frac{V_1}{V_2}$</td>
</tr>
<tr>
<td>Q4 What is Reverse Current Ratio</td>
<td>A4. $D' = \frac{I_1}{I_2}$</td>
</tr>
<tr>
<td>Q5 What is Reverse Transfer Impedance</td>
<td>A5. $B' = \frac{V_1}{I_2}$</td>
</tr>
<tr>
<td>Q6 What is Reverse Transfer Admittance</td>
<td>A6. $C' = \frac{I_1}{V_2}$</td>
</tr>
<tr>
<td>Q7 Is Z inversely proportional to Y in one port network?</td>
<td>A7. Yes.</td>
</tr>
<tr>
<td>Q8 Is Z inversely proportional to Y in two port network?</td>
<td>A8. No.</td>
</tr>
<tr>
<td>Q9 The number of possible combinations generated by four variables taken two at a time in a two-port network is (a) Four (b) two (c) six</td>
<td>A9. (c)</td>
</tr>
</tbody>
</table>
EXPERIMENT-10

AIM: To Study P-Spice Software.

THEORY: SPICE (Simulation Program for Integrated Circuits Emphasis) is an analog circuit simulator developed at Berkeley. Many different versions of SPICE are available from many different vendors. Common SPICEs include HSPICE, PSPICE, and B 2 SPICE. SPICE takes a circuit net list and performs mathematical simulation of the circuit’s behavior. A net list describes the components in the circuit and how they are connected. SPICE can simulate DC operating point, AC response, transient response, and other useful simulations.

Inputting your Circuit
1. From the Start Menu, select Programs → PSPICE Student → Schematics. You are now running the schematic capture program, which you will use to enter the simple integrator
2. Add an ideal op-amp:
   - Open the Get New Part window by clicking on the binocular icon or using the Draw menu.
   - Search for available op-amp models by typing "op-amp" in the description search box.
   - You should see a list of available op-amp models. Notice the 741 and 411 are both available in lab. It is possible to add more models if you ever need to do so.
   - Select OPAMP, the ideal op-amp model. Click on "Place and Close"
   - Place the op-amp on the sheet by left-clicking the mouse.
   - Double click on the op-amp. You should see a window listing the parameters for the part. Notice you can set the op-amp gain. You don't need to change any parameters for this part. If you need to know what the parameters mean for a part you are using, the help contents has a list of parameters and their meaning.
3. Add the resistors and capacitors:
   - Use Get New Part to place the resistors and capacitors on the sheet. Use the R and C components (ideal resistor and ideal capacitor.)
   - Set the component values by double clicking on the value already displayed next to the part. You can also change the component value by double clicking on the component itself and changing the correct parameter.
4. Add an AC voltage source.
   - Use Get New Part to place an AC voltage source (VAC).
   - Set the AC magnitude (ACMAG) to 1V.
5. Add a ground (GND_EARTH)
6. Connect the components using the Draw Wire button, or use the Draw menu.
7. Name the nodes to useful names
   - Double click on the wire between the output of the op-amp and the resistor. Name this node something like "Vout".
   - Rename the other nodes as well. The ground node is already labelled "0" and cannot be changed to anything else.
Simulating Your Circuit

1. Set the simulation parameters.
   - Go to Analysis → Setup.
   - Enable AC Sweep
   - Click on the AC Sweep button.
   - Set the AC parameters to:
     o Sweep Type = Decade
     o Pts/Decade = 101
     o Start Freq = 10
     o End Freq = 1meg

2. Save your schematic. Save it in D:\SAVE STUFF HERE\ your_folder_here

3. Simulate the circuit by clicking on the simulate button, or use the Analysis menu.

Plotting the Results

1. When the plotting window appears, plot the results:
   - Click on the Add Trace button or use the Trace menu.
   - Uncheck Alias Names
   - You can plot any of the parameters seen on the left. Select and plot V (Vout). Make sure the plot matches what you expect.
   - Set the y-axis to a log scale by double clicking on the axis.
   - Now, plot the same data using dB for the y-axis.
     o Trace → Delete All Traces
     o Set the y-axis back to the linear scale.
     o Add Trace
     o In the Trace Expression box, type: 20 _ log10 (V (V out)) Click OK.
   - Find the -3dB point on the plot using the markers:
     o Turn on the cursors using the Toggle Cursors button or the Trace → Cursor menu.
     o A small window has appeared showing the position of the cursors and their values. The left mouse button moves one cursor and the right mouse button moves the second.
     o Using the cursors and the -3dB point by setting one cursor to 10Hz and move the second cursor until their difference is 3dB. Is this the frequency you expect?

CONCLUSION: Hence we have studied the P-Spice Software.
QUIZ QUESTIONS & ANSWERS

Q. 1 What is P-SPICE Design Suite?
Ans. P-SPICE Design Suite is a powerful yet affordable circuit simulation and PCB design software package.

Q. 2 Why P-SPICE Design Suite is used?
Ans. It is used for analyzing, designing, and real time testing of analog, digital, VHDL, MCU, and mixed electronic circuits and their PCB layouts.

Q. 3 What is unique feature of P-SPICE?
Ans. A unique feature of PSPICE is that you can bring your circuit to life with the optional USB controlled.

Q. 4 How it is used to compute computational power?
Ans. To meet this requirement PSPICE v9 has the ability to utilize the increasingly popular scalable multi-thread CPUs.

Q. 5 What is the use of schematic editor?
Ans. It enhances your schematics by adding text and graphics elements such lines, arcs arrows, frames around the schematics and title blocks.

Q. 6 How many manufacturer models it contain?
Ans. More than 20,000.

Q. 7 Name all the Virtual Instruments used in it.

Q. 8 What is Real-time Storage Oscilloscope?
Ans. It observes the actual time response of your circuit.

Q. 9 What is Real-time Signal Analyzer?
Ans. It measure the frequency response of your circuit in real-time.

Q. 10 What’s role P-SPICE play in Integrated PCB design?
Ans. The new fully integrated layout module of P-SPICE has all the features you need for advanced PCB design, including multilayer PCB's with split power plane layers, powerful autoplacement & autorouting, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, fanout, 3D view of your PCB design from any angle, Gerber file output and much more.
EXPERIMENT NO: 11

AIM: Introduction to circuit creation and simulation software TINAPRO.

APPARATUS: PC installed with TINAPRO

THEORY: The study of TINAPRO mainly consists of: Introduction to TINAPRO Capture: Generation of Schematic, Generation of net list.

SCHEMATIC: A schematic is merely a collection of electronic symbols connected together with virtual “wires.” The main reason you need a schematic when fabricating a printed circuit board is to provide input (a net list) to your layout and routing tool.

NETLIST: A net list is a file, usually ASCII text, which defines the connections between the components in your design.

CREATING PROJECT: To create a new project, use Capture’s Project Wizard. The Project Wizard provides you with the framework for creating any kind of project.

1 Launch Capture
2 From the File menu, choose New > Project.
3 In the New Project dialog box, specify the project name
4 To specify the project type, select Analog or Mixed A/D.
5 Specify the location where you want the project files to be created and click OK.
6 In the Create PSpice Project dialog box, select the Create a blank project option button.

Adding parts: To add parts to your design:

1 From the Place menu in Capture, select Part.
2 In the Place Part dialog box, first select the library from which the part is to be added and then instantiate the part on the schematic page
While working with the Capture, add parts from “Name of Library”. OLB.
To add libraries to the project, select the Add Library button.
3 Browse to <install_dir>/tools/capture/library/pspice/eval.olb.

Connecting parts: After placing the required parts on the schematic page, you need to connect the parts. From the Place menu, choose Wire.

Net List: Save the schematic and close the schematic page.
Open tools and create net list.
Select Layout tab
Be sure to put the *.MNL file in a unique folder.
Latter many more design files will be generated and it will be much easier to sort them out if the design is by itself.
Click on OK
The net list that Layout needs has been created. The file has the name of the project.MNL

**CONCLUSION:** Thus we have studied the TINAPRO circuit capturing, Generation of Schematic and net list.

**QUIZ QUESTIONS & ANSWERS**

Q. 1 What is TINA Design Suite?
Ans. TINA Design Suite is a powerful yet affordable circuit simulation and PCB design software package.

Q.2 Why TINA Design Suite is used?
Ans. It is used for analyzing, designing, and real time testing of analog, digital, VHDL, MCU, and mixed electronic circuits and their PCB layouts.

Q.3 What is unique feature of TINA?
Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB controlled.

Q.4 How it is used to compute computational power?
Ans. To meet this requirement TINA v9 has the ability to utilize the increasingly popular scalable multi-thread CPUs.

Q.5 What is the use of schematic editor in Tina Pro?
Ans. It enhances your schematics by adding text and graphics elements such lines, arcs arrows, frames around the schematics and title blocks.

Q.6 How many manufacturer models it contain?
Ans. More than 20,000.

Q.7 Name all the Virtual Instruments used in it.

Q.8 What is Real-time Storage Oscilloscope?
Ans. It observes the actual time response of your circuit.

Q.9 What is Real-time Signal Analyzer?
Ans. It measure the frequency response of your circuit in real-time.

Q.10 What’s role Tina play in Integrated PCB design?
Ans. The new fully integrated layout module of TINA has all the features you need for advanced PCB design, including multilayer PCB's with split power plane layers, powerful autoplacement & autorouting, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, fanout, 3D view of your PCB design from any angle, Gerber file output and much more.
EXPERIMENT NO: 12

AIM: Introduction to Layout Tool, and creating Layout board using TINAPRO.

APPARATUS: PC installed with TINAPRO

THEORY: TINAPRO Layout
TINAPRO tool used for PCB routing and floor-planning

LAYOUT: Layout is a circuit board layout tool that accepts a layout-compatible circuit net list (ex. from Capture CIS) and generates an output layout files that suitable for PCB fabrication

CREATING LAYOUT BOARD:
Having created the layout net list, the next step is to create a new board in Layout.
Launch Layout
Create the Layout board file
When you create a new board file in OrCAD Layout, you merge the electrical information from the layout net list (.MNL) and physical information from a template file (.TPL) or a technology file (.TCH) to create a new board design (.MAX). Therefore, to be able to create a board file for a new design in Layout, you need to provide a template file and a net list. A template (.TPL) file describes the characteristics of a physical board. A template can include information, such as the board outline, the design origin, the layer definitions, grid settings, spacing rules, and default track widths.

1. From the File menu in OrCAD Layout, choose New. The Auto ECO dialog box appears.
2. In the Input Layout TCH or TPL or MAX file text box, specify the name and the location of the technology file to be used for your board
3. In the Input MNL net list file text box, specify the location of the FULLADD.MNL created in the Creating Layout net list section.
4. From the drop-down list in the Options section, select Auto ECO.

CONCLUSION: Thus we have studied the TINAPRO circuit TINAPRO Layout and tool used for PCB routing and floor-planning.

QUIZ QUESTIONS & ANSWERS
Q.1 What is layout?
Ans. Layout is a circuit board layout tool that accepts a layout-compatible circuit netlist (ex. from Capture CIS) and generates an output layout files that suitable for PCB fabrication.

Q.2 What do you mean by SCHEMATIC?
Ans. A schematic is merely a collection of electronic symbols connected together with virtual “wires.” The main reason you need a schematic when fabricating a printed circuit board is to provide input (a netlist) to your layout and routing tool.

Q.3 What is netlist?
Ans. A netlist is a file, usually ASCII text, which defines the connections between the components in your design.

Q.4 What's new in version 9.2 of Tina?
Ans. Schematic Symbol Editor (useable with the Macro Wizard) is included, so you can create your own symbols for imported SPICE macro models.

Q.5 What's new in version 9.3 of Tina?
Ans. It does not require active or non-linear components for analysis (so you can now run a circuit using just passives).

Q.6 What is user-friendly interface?
Ans. The user-friendly interface makes it easy to find the necessary tools for designing a circuit. There are several switches, meters, sources, semiconductors and spice macros to choose from. When evaluating a circuit in function mode, a multimeter, oscilloscope, a signal analyzer and others can also be used.

Q.7 What is the use of schematic editor in Tina Pro?
Ans. It enhances your schematics by adding text and graphics elements such as lines, arcs, arrows, frames around the schematics and title blocks.

Q.8 How many manufacturer models does it contain?
Ans. More than 20,000.

Q.9 What is unique feature of TINA?
Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB controlled.

Q.10 How many number or devices and nodes can be included in it?
Ans. The number or devices and nodes that can be included in a circuit is not limited.
EXPERIMENT NO: 13

AIM: Design a RLC resonance circuit & verify the transient response for different values of R, L & C.

APPARATUS: PC installed with TINAPRO

CIRCUIT DIAGRAM:

![Circuit Diagram]

PROGRAM:

```plaintext
****Exp Transient Response of an RLC-circuit with a sinusoidal input voltage
*SIN (VO VA FREQ) ; Simple sinusoidal source
VIN 1 0 SIN (0 10V 5KHZ) ; Sinusoidal input voltage
R1 1 2 2
L1 2 3 50UH
C1 3 0 10UF
.TRAN 1US 500US ; Transient analysis
.PLOT TRAN V (3) V (1) ; Plots on the output file
.PROBE ; Graphical waveform analyzer
.END ; End of circuit file
```

RESULT:

![Graph of Transient Response]

CONCLUSION: Thus we have studied transient response of RLC circuit for different values of R, L & C.
QUIZ QUESTIONS & ANSWERS

Q.1 What is layout?
Ans. Layout is a circuit board layout tool that accepts a layout-compatible circuit netlist (ex. from Capture CIS) and generates an output layout files that suitable for PCB fabrication.

Q.2 What do you mean by SCHEMATIC?
Ans. A schematic is merely a collection of electronic symbols connected together with virtual “wires.” The main reason you need a schematic when fabricating a printed circuit board is to provide input (a netlist) to your layout and routing tool.

Q.3 What is netlist?
Ans. A netlist is a file, usually ASCII text, which defines the connections between the components in your design.

Q.4 What's new in version 9.2 of Tina?
Ans. Schematic Symbol Editor (useable with the Macro Wizard) is included, so you can create your own symbols for imported SPICE macro models.

Q.5 What's new in version 9.3 of Tina?
Ans. It does not require active or non-linear components for analysis (so you can now run a circuit using just passives).

Q.6 What is user-friendly interface?
Ans. The user-friendly interface makes it easy to find the necessary tools for designing a circuit. There are several switches, meters, sources, semiconductors and spice macros to choose from. When evaluating a circuit in function mode, a multimeter, oscilloscope, a signal analyzer and others can also be used.

Q.7 What is the use of schematic editor in Tina Pro?
Ans. It enhance your schematics by adding text and graphics elements such lines, arcs arrows, frames around the schematics and title blocks.

Q.8 How many manufacturer models it contain?
Ans. More than 20,000.

Q.9 What is unique feature of TINA?
Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB controlled.

Q.10 How many number or devices and nodes can be included in it?
Ans. The number of devices and nodes that can be included in a circuit are not limited.